
1 Inštalácia ATPDraw 
 

Inštaláciu spustíme z inštalačného CD súborom eeusetup.exe. Po spustení sa zobrazí 
uvítacie okno, v ktorom je možné prečítať si informácie k programu (tlačidlo Information ), 
nainštalovať jednotlivé súčasti programu (tlačidlo Programs), nakopírovať do počítača rôzne 
návody a inštrukcie k programu (tlačidlo Data) alebo ukončiť inštaláciu (tlačidlo Exit ). 
 
1.1 Inštalácia súčastí programu ATP 
 
 V nasledujúcom texte budú popísané jednotlivé kroky inštalácie so zobrazením 
príslušného okna. 
 
1.1.1 Inštalácia ATP Control Center 1.0 
 
 V uvítacom okne stlačíme tlačidlo Programs. 

 
Obr. 1 Uvítacie okno 

 
V ľavom výberovom menu zvolíme položku ATP Control Center 1.0 a stlačíme 

tlačidlo Install . 

 
Obr. 2 Inštalácia jednotlivých súčastí programu ATP 



V ďalšom okne potvrdíme inštaláciu tlačidlom Next. 

 
Obr. 3 Informácia o inštalovaní ATP Control Center 1.0 

 
 Ak súhlasíme s licenčnými podmienkami stlačíme tlačidlo Yes. 

 
Obr. 4 Licenčné podmienky 

 
 
 
 
 
 



V ďalšom okne stlačíme pre pokračovanie tlačidlo Next. 

 
Obr. 5 Pokračovanie inštalácie 

 
Zadáme meno a spoločnosť a potvrdíme tlačidlom Next. 

 
Obr. 6 Zadanie mena a názvu spoločnosti 

 
 
 
 
 
 



V ďalšom okne zadáme cieľový adresár, pre inštaláciu ATP Control Center 1.0 
pomocou tlačidla Browse... (pozn.: ponecháme túto položku nezmenenú) a stlačíme tlačidlo 
Next. 

 
Obr. 7 Zadanie inštalačnej cesty 

 
Pokračujeme stlačením tlačidla Next. 

 
Obr. 8 Zadanie názvu programovej skupiny 

 
 
 
 



Pre spustenie samotnej inštalácie ATP Control Center 1.0 stlačíme tlačidlo Next. 

 
Obr. 9 Spustenie inštalácie 

 
Úspešnú inštaláciu potvrdíme tlačidlom Finish. 

 
Obr. 10 Potvrdenie úspešnej inštalácie 

 
 
 
 
 
 



1.1.2 Inštalácia Watcom ATP for Win95/98/NT 
 
 V uvítacom okne stlačíme tlačidlo Programs. 

 
Obr. 11 Uvítacie okno 

 
V ľavom výberovom menu zvolíme položku Watcom ATP for Win95/98/NT 

a stlačíme tlačidlo Install . 

 
Obr. 12 Inštalácia jednotlivých súčastí programu ATP 

 
 
 
 
 
 
 
 



V ďalšom okne potvrdíme inštaláciu tlačidlom Next. 

 
Obr. 13 Informácia o inštalovaní Watcom ATP for Win95/98/NT 

 
 Ak súhlasíme s licenčnými podmienkami stlačíme tlačidlo Yes. 

 
Obr. 14 Licenčné podmienky 

 
 
 
 
 
 



Zadáme meno a spoločnosť a potvrdíme tlačidlom Next. 

 
Obr. 15 Zadanie mena a názvu spoločnosti 

 
 

V ďalšom okne zadáme cieľový adresár, pre inštaláciu Watcom ATP for 
Win95/98/NT pomocou tlačidla Browse... (pozn.: ponecháme túto položku nezmenenú) 
a stlačíme tlačidlo Next. 

 
Obr. 16 Zadanie inštalačnej cesty 

 
 
 



Vyberieme si typickú inštaláciu a stlačíme pre potvrdenie tlačidlo Next. 

 
Obr. 17 Výber typu inštalácie 

 
Pokračujeme stlačením tlačidla Next. 

 
Obr. 18 Zadanie názvu programovej skupiny 

 
 
 
 
 
 



Pre spustenie samotnej inštalácie Watcom ATP for Win95/98/NT stlačíme tlačidlo 
Next. 

 
Obr. 19 Spustenie inštalácie 

 
Pre správnu funkciu programu zvolíme voľbu reštartu a stlačíme tlačidlo Finish 

(pozn.: nutné len pri operačnom systéme Windows 98, inak postačuje voľba neskoršieho 
reštartu). 

 
Obr. 20 Potvrdenie úspešnej inštalácie a reštart PC 

 
 
 



Úspešnú inštaláciu v prípade neskoršieho reštartu potvrdíme tlačidlom Finish. 

 
Obr. 21 Potvrdenie úspešnej inštalácie 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



1.1.3 Inštalácia GNU-Mingw32 ATP for Win95/98/NT 
 
 V uvítacom okne stlačíme tlačidlo Programs. 

 
Obr. 22 Uvítacie okno 

 
V ľavom výberovom menu zvolíme položku GNU-Mingw32 ATP for Win95/98/NT 

a stlačíme tlačidlo Install . 

 
Obr. 23 Inštalácia jednotlivých súčastí programu ATP 

 
 
 
 
 
 
 
 



V ďalšom okne potvrdíme inštaláciu tlačidlom Next. 

 
Obr. 24 Informácia o inštalovaní GNU-Mingw32 ATP for Win95/98/NT 

 
 Ak súhlasíme s licenčnými podmienkami stlačíme tlačidlo Yes. 

 
Obr. 25 Licenčné podmienky 

 
 
 
 
 
 



V ďalšom okne pokračujeme stlačením tlačidla Next. 

 
Obr. 26 Pokračovanie inštalácie 

 
Zadáme meno a spoločnosť a potvrdíme tlačidlom Next. 

 
Obr. 27 Zadanie mena a názvu spoločnosti 

 
 
 
 
 



V ďalšom okne zadáme cieľový adresár, pre inštaláciu GNU-Mingw32 ATP for 
Win95/98/NT pomocou tlačidla Browse... (pozn.: ponecháme túto položku nezmenenú) 
a stlačíme tlačidlo Next. 

 
Obr. 28 Zadanie inštalačnej cesty 

 
Vyberieme si typickú inštaláciu a stlačíme pre potvrdenie tlačidlo Next. 

 
Obr. 29 Výber typu inštalácie 

 
 
 
 



Pokračujeme stlačením tlačidla Next. 

 
Obr. 30 Zadanie názvu programovej skupiny 

 
Pre spustenie samotnej inštalácie GNU-Mingw32 ATP for Win95/98/NT stlačíme 

tlačidlo Next. 

 
Obr. 31 Spustenie inštalácie 

 
 
 
 



Pre správnu funkciu programu zvolíme voľbu reštartu a stlačíme tlačidlo Finish 
(pozn.: nutné len pri operačnom systéme Windows 98, inak postačuje voľba neskoršieho 
reštartu). 

 
Obr. 32 Potvrdenie úspešnej inštalácie a reštart PC 

 
Úspešnú inštaláciu v prípade neskoršieho reštartu potvrdíme tlačidlom Finish. 

 
Obr. 33 Potvrdenie úspešnej inštalácie 

 
 
 
 



1.1.4 Inštalácia Salford ATP for Win3.x/95/98 
 
 V uvítacom okne stlačíme tlačidlo Programs. 

 
Obr. 34 Uvítacie okno 

 
V ľavom výberovom menu zvolíme položku Salford ATP for Win3.x/95/98 

a stlačíme tlačidlo Install . 

 
Obr. 35 Inštalácia jednotlivých súčastí programu ATP 

 
 
 
 
 
 
 
 



V ďalšom okne potvrdíme inštaláciu tlačidlom Next. 

 
Obr. 36 Informácia o inštalovaní Salford ATP for Win3.x/95/98 

 
 Ak súhlasíme s licenčnými podmienkami stlačíme tlačidlo Yes. 

 
Obr. 37 Licenčné podmienky 

 
 
 
 
 
 



V ďalšom okne pokračujeme stlačením tlačidla Next. 

 
Obr. 38 Pokračovanie inštalácie 

 
Zadáme meno a spoločnosť a potvrdíme tlačidlom Next. 

 
Obr. 39 Zadanie mena a názvu spoločnosti 

 
 
 
 
 
 



V ďalšom okne zadáme cieľový adresár, pre inštaláciu Salford ATP for Win3.x/95/98 
pomocou tlačidla Browse... (pozn.: ponecháme túto položku nezmenenú) a stlačíme tlačidlo 
Next. 

 
Obr. 40 Zadanie inštalačnej cesty 

 
Vyberieme si typickú inštaláciu a stlačíme pre potvrdenie tlačidlo Next. 

 
Obr. 41 Výber typu inštalácie 

 
 
 
 



Pokračujeme stlačením tlačidla Next. 

 
Obr. 42 Zadanie názvu programovej skupiny 

 
Pre spustenie samotnej inštalácie Salford ATP for Win3.x/95/98 stlačíme tlačidlo 

Next. 

 
Obr. 43 Spustenie inštalácie 

 
 
 
 



Pre správnu funkciu programu zvolíme voľbu reštartu a stlačíme tlačidlo Finish 
(pozn.: nutné len pri operačnom systéme Windows 98, inak postačuje voľba neskoršieho 
reštartu). 

 
Obr. 44 Potvrdenie úspešnej inštalácie a reštart PC 

 
Úspešnú inštaláciu v prípade neskoršieho reštartu potvrdíme tlačidlom Finish. 

 
Obr. 45 Potvrdenie úspešnej inštalácie 

 
 
 
 



1.1.5 Inštalácia ATPDraw version 2.0 
 

V uvítacom okne stlačíme tlačidlo Programs. 

 
Obr. 46 Uvítacie okno 

 
V ľavom výberovom menu zvolíme položku ATPDraw version 2.0 a stlačíme tlačidlo 

Install . 

 
Obr. 47 Inštalácia jednotlivých súčastí programu ATP 

 
 
 
 
 
 
 
 



V ďalšom okne potvrdíme inštaláciu tlačidlom Next. 

 
Obr. 48 Informácia o inštalovaní ATPDraw version 2.0 

 
V ďalšom okne zadáme cieľový adresár, pre inštaláciu ATPDraw version 2.0 pomocou 

tlačidla Browse... (pozn.: túto položku musíme zmeniť, pretože táto verzia ATPDraw 
nepodporuje názvy adresárov dlhšie ako 8+3 znaky). 

 
Obr. 49 Zadanie inštalačnej cesty 

 
 
 
 



Do kolónky Path (cesta k programu) vpíšeme cestu pre nainštalovanie ATP Draw 
version 2.0 (pozn.: zvolíme cestu: c:\EEUG\ATPDraw ) a stlačíme tlačidlo OK . 

 
Obr. 50 Vpísanie inštalačnej cesty 

 
V nasledujúcom okne potvrdíme vytvorenie nového adresára stlačením tlačidla Yes. 

 
Obr. 51 Potvrdenie vytvorenia adresára 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



V ďalšom okne stlačením tlačidla Next potvrdíme inštalovanie programu ATP Draw 
version 2.0. 

 
Obr. 52 Potvrdenie inštalačnej cesty 

 
Pre spustenie samotnej inštalácie ATP Draw version 2.0. stlačíme tlačidlo Next. 

 
Obr. 53 Spustenie inštalácie 

 
 
 
 
 



Úspešnú inštaláciu potvrdíme tlačidlom Finish. 

 
Obr. 54 Potvrdenie úspešnej inštalácie 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



1.1.6 Inštalácia PCPLOT version 1.0, R68 
 
 V uvítacom okne stlačíme tlačidlo Programs. 

 
Obr. 55 Uvítacie okno 

 
V ľavom výberovom menu zvolíme položku PCPLOT version 1.0, R68 a stlačíme 

tlačidlo Install . 

 
Obr. 56 Inštalácia jednotlivých súčastí programu ATP 

 
 
 
 
 
 
 
 



V ďalšom okne potvrdíme inštaláciu tlačidlom Next. 

 
Obr. 57 Informácia o inštalovaní PCPLOT version 1.0, R68 

 
 Ak súhlasíme s licenčnými podmienkami stlačíme tlačidlo Yes. 

 
Obr. 58 Licenčné podmienky 

 
 
 
 
 
 



V ďalšom okne pokračujeme stlačením tlačidla Next. 

 
Obr. 59 Pokračovanie inštalácie 

 
Zadáme meno a spoločnosť a potvrdíme tlačidlom Next. 

 
Obr. 60 Zadanie mena a názvu spoločnosti 

 
 
 
 
 
 



V ďalšom okne zadáme cieľový adresár, pre inštaláciu PCPLOT version 1.0, R68 
pomocou tlačidla Browse... (pozn.: ponecháme túto položku nezmenenú) a stlačíme tlačidlo 
Next. 

 
Obr. 61 Zadanie inštalačnej cesty 

 
Pokračujeme stlačením tlačidla Next. 

 
Obr. 62 Zadanie názvu programovej skupiny 

 
 
 
 



Pre spustenie samotnej inštalácie PCPLOT version 1.0, R68 stlačíme tlačidlo Next. 

 
Obr. 63 Spustenie inštalácie 

 
Úspešnú inštaláciu potvrdíme tlačidlom Finish. 

 
Obr. 64 Potvrdenie úspešnej inštalácie 

 
 
 
 
 
 



1.1.7 Inštalácia PlotXY plotting program 
 
 V uvítacom okne stlačíme tlačidlo Programs. 

 
Obr. 65 Uvítacie okno 

 
V ľavom výberovom menu zvolíme položku PlotXY plotting program  a stlačíme 

tlačidlo Install . 

 
Obr. 66 Inštalácia jednotlivých súčastí programu ATP 

 
 
 
 
 
 
 
 



V ďalšom okne potvrdíme inštaláciu tlačidlom Next. 

 
Obr. 67 Informácia o inštalovaní PlotXY plotting program 

 
 Ak súhlasíme s licenčnými podmienkami stlačíme tlačidlo Yes. 

 
Obr. 68 Licenčné podmienky 

 
 
 
 
 
 



Zadáme meno a spoločnosť a potvrdíme tlačidlom Next. 

 
Obr. 69 Zadanie mena a názvu spoločnosti 

 
V ďalšom okne zadáme cieľový adresár, pre inštaláciu PlotXY plotting program 

pomocou tlačidla Browse... (pozn.: ponecháme túto položku nezmenenú) a stlačíme tlačidlo 
Next. 

 
Obr. 70 Zadanie inštalačnej cesty 

 
 
 
 



Pokračujeme stlačením tlačidla Next. 

 
Obr. 71 Zadanie názvu programovej skupiny 

 
Pre spustenie samotnej inštalácie PlotXY plotting program stlačíme tlačidlo Next. 

 
Obr. 72 Spustenie inštalácie 

 
 
 
 
 
 



Úspešnú inštaláciu potvrdíme tlačidlom Finish. 

 
Obr. 73 Potvrdenie úspešnej inštalácie 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



1.1.8 Inštalácia Programmer’s File Editor 32-bit Edition 
 
 V uvítacom okne stlačíme tlačidlo Programs. 

 
Obr. 74 Uvítacie okno 

 
V ľavom výberovom menu zvolíme položku Programmer’s File Editor 32-bit 

Edition  a stlačíme tlačidlo Install . 

 
Obr. 75 Inštalácia jednotlivých súčastí programu ATP 

 
 
 
 
 
 
 
 



V ďalšom okne potvrdíme inštaláciu tlačidlom Unzip. 

 
Obr. 76 Informácia o inštalovaní Programmer’s File Editor 32-bit Edition 

 
Po úspešnom nainštalovaní v nasledujúcom okne stlačíme tlačidlo OK . 

 
Obr. 77 Okno úspešnej inštalácie 

 
Uzavrieme okno WinZip Self-Extractor – pfe101i.exe tlačidlom Close a tiež uvítacie 

inštalačné okno tlačidlom Exit . 

 
Obr. 78 Uvítacie okno 

 
 
 
 
 
 
 



1.2 Nastavenie ciest k jednotlivým súčastiam programu ATPDraw 
 
 Po úspešnom nainštalovaní jednotlivých súčastí programu ATP nastavíme ešte cesty 
k súčasti, konkrétne k podprogramu ATPDraw. 
 
 Spustíme program ATPDraw z miesta, kde sme ho nainštalovali. Ak sme postupovali 
podľa inštrukcií uvedených vyššie, cesta k danému súboru bude: 
 

C:\EEUG\ATPDraw\ATPDRAW.EXE 
 
 Z horného menu ikon stlačíme ikonu nový dokument (biely prázdny formulár) alebo 
z horného menu vyberieme File → New. 

 
Obr. 79 Ikonové menu 

 
Ďalej z horného menu vyberieme ATP → Edit Commands... a postupne zmeníme 

jednotlivé cesty k súčastiam (podprogramom) ATP. 
 
1.2.1 &&&&ATP 
 

Nastavíme sa na položku run &&&&ATP a stlačíme tlačidlo Browse... 

 
Obr. 80 Zmena cesty pre &ATP 

 
 
 
 
 
 
 
 



Vyhľadáme v počítači daný súbor runATP_W.bat  (C:\EEUG\ATPDraw\  
runATP_W.bat)  a stlačíme tlačidlo Open. 

 
Obr. 81 Vyhľadanie súboru runATP_W.bat 

 
Zmenu aktualizujeme tlačidlom Update, inak nebudú zmeny akceptované. 

 
Obr. 82 Aktualizácia zmeny cesty k súboru runATP_W.bat 

 
Podobne postupujeme aj pri ďalších súboroch. 

 
 
 
 
 
 
 
 
 
 



1.2.2 PCPlot 
 

Nastavíme sa na položku run PCPlot a stlačíme tlačidlo Browse... 

 
Obr. 83 Zmena cesty pre PCPlot 

 
Vyhľadáme v počítači daný súbor WPCplot.exe (C:\EEUG\WPCPLOT\ 

WPCplot.exe) a stlačíme tlačidlo Open. 

 
Obr. 84 Vyhľadanie súboru WPCplot.exe 

 
 
 
 
 
 
 
 
 
 



Zmenu aktualizujeme tlačidlom Update, inak nebudú zmeny akceptované. 

 
Obr. 85 Aktualizácia zmeny cesty k súboru WPCplot.exe 

 
1.2.3 ATP (file) 
 

Nastavíme sa na položku run ATP (file)  a stlačíme tlačidlo Browse... 

 
Obr. 86 Zmena cesty pre ATP (file) 

 
 
 
 
 
 
 
 



Vyhľadáme v počítači daný súbor runATP_W.bat  (C:\EEUG\ATPDraw\  
runATP_W.bat)  a stlačíme tlačidlo Open. 

 
Obr. 87 Vyhľadanie súboru runATP_W.bat 

 
Zmenu aktualizujeme tlačidlom Update, inak nebudú zmeny akceptované. 

 
Obr. 88 Aktualizácia zmeny cesty k súboru runATP_W.bat 

 
 
 
 
 
 
 
 
 
 
 
 



1.2.3 PlotXY 
 

Nastavíme sa na položku run PlotXY  a stlačíme tlačidlo Browse... 

 
Obr. 89 Zmena cesty pre PlotXY 

 
Vyhľadáme v počítači daný súbor PlotXY.exe (C:\EEUG\PlotXY\PlotXY.exe) 

a stlačíme tlačidlo Open. 

 
Obr. 90 Vyhľadanie súboru PlotXY.exe 

 
 
 
 
 
 
 
 
 
 



Zmenu aktualizujeme tlačidlom Update, inak nebudú zmeny akceptované. 

 
Obr. 91 Aktualizácia zmeny cesty k súboru PlotXY.exe 

 
Po ukončení zmien zavrieme okno Edit Commands stlačením tlačidla Exit . 

 
 Nastavené cesty si skontrolujeme výberom z horného menu Tools → Options… 
v záložke Preferences. 

 
Obr. 92 Nastavenie ciest k súborom runATP_W.bat a runAF.bat 

 
 
 
 
 
 
 



Podobne skontrolujeme nastavenia adresárov výberom z horného menu 
Tools→ Options…v záložke Directories. 

 
Obr. 93 Nastavenie adresárov k ATPDraw 

 
Nakoniec ešte uskutočnené zmeny potvrdíme uložením nastavení programu: Tools → 

Save Options. 
 
Týmto postupom sa nainštalovala verzia 2.0 programu ATP Draw, v ktorej sú 

k dispozícii základné prvky elektrizačnej sústavy. Pre zvýšenie možností modelovania viac 
sofistikovanejších prvkov elektrizačnej sústavy, je potrebné uskutočniť upgrade programu na 
vyššiu verziu, konkrétne 4.02p. 

Na inštalačnom CD sa nachádza v adresári x:\Patch\atpdraw40\ inštalačný súbor 
setup.exe, ktorý spustíme. 
 
1.3 Inštalácia ATPDraw version 4.0 
 

V spustenom okne potvrdíme inštaláciu tlačidlom Next. 



 
Obr. 94 Informácia o inštalovaní ATPDraw version 4.0 

 

 
Obr. 95 Zadanie mena a názvu spoločnosti 

 
V ďalšom okne zadáme cieľový adresár, pre inštaláciu ATPDraw version 4.0 pomocou 

tlačidla Browse... (pozn.: túto položku musíme zmeniť, pretože táto verzia ATPDraw 
nepodporuje názvy adresárov dlhšie ako 8+3 znaky). 



 
Obr. 96 Zadanie inštalačnej cesty 

 
Do kolónky Path (cesta k programu) vyhľadáme cestu pre nainštalovanie ATP Draw 

version 4.0 (pozn.: zvolíme cestu: c:\EEUG\ATPDraw ) a stlačíme tlačidlo OK . 

 
Obr. 97 Vyhľadanie inštalačnej cesty 

 
 
 
 
 
 
 
 
 
 



V ďalšom okne stlačením tlačidla Next potvrdíme inštalovanie programu ATP Draw 
version 4.0. 

 
Obr. 98 Potvrdenie inštalačnej cesty 

 
Pre spustenie samotnej inštalácie ATP Draw version 4.0. stlačíme tlačidlo Next. 

 
Obr. 99 Spustenie inštalácie 

 
 
 
 
 



Úspešnú inštaláciu potvrdíme tlačidlom Finish. 

 
Obr. 100 Potvrdenie úspešnej inštalácie 

 
1.4 Inštalácia ATPDraw version 4.02p 
 

Obsah adresára na CD x:\Patch\atpdraw40p2\ (4 súbory: ATPDraw.CNT, 
Atpdraw.exe, ATPDraw.hlp, ATPDraw.scl) prekopírujeme do adresára v počítači, t.j. do 
c:\EEUG\ATPDraw\  a prepíšeme pôvodné súbory. 
 
1.5 Upgrade podprogramu PlotXY 
 

Podobným postupom, ako bolo spomenuté v predchádzajúcej podkapitole, postupuje 
sa pri upgrade podprogramu PlotXY. Obsah adresára na CD x:\Patch\PlotXY\ sa prekopíruje 
do adresára v počítači, t.j. do. c:\EEUG\PlotXY\  a prepíšu sa tak pôvodné súbory. 
 


